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Important Note! Read This! : 

The 3D Assistants Lite are not normal filters. They are keyframe assistants. As such, they show up under the Windows 
menu in After Effects, not the Effects menu.

Since they are designed to work with 3D layers, unless you have a 3D layer selected, all of the Assistants will be grayed 
out. To activiate them just selected any 3D layer or group of 3D layers. The Assistants do not work with Cameras or 
Lights.

In this manual, there are some references to the full version of the 3D Assistants. These have been left in because we felt 
they provided useful information about AE’s 3D space and would be beneficial regardless of whether you had the particu-
lar assistant being used.

Support and Stuff

We hope that you find 3D Assistants EZ to give you all the control you could want, while simple enough that you can set 
everything up in a few minutes. It’s our desire to make sure you’re satisfied with your purchase, and if you have any ques-
tions, comments, or whatever, we’d love to hear them.

If there’s anything you’d like to see added to any of the filters, a completely different effect that you’d like to see a plug-in 
for, or would just like to say hello… definitely send us an email at info@digitalanarchy.com.

If you have any technical problems or questions related to the filters, please email:
 support@digitalanarchy.com. 
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About the Assistants

The 3d Assistants are a collection of keyframe assistants that function 
much like the keyframe assistants that ship with After Effects, like The Wig-
gler, Align & Distribute, etc. While these keyframe assistants do allow you 
to create keyframes, their main purpose is to allow you to arrange and 
manage your layers in 3d space. This gives you the ability to create clus-
ters of layers, cubes, tunnels, and many other shapes out of your layers, 
all within AE’s 3D space. Since these are keyframe assistants, there is no 
render time on top of the time it takes for AE to render your layers. You can 
use the AE cameras to fly around your layers, and you can create other 

3d layers that will interact in 3d space with the layers positioned by the 
assistants. This gives the 3d assistants an advantage over filters that use 3D 
space, since they only work within their 3D space, not AE’s. This means 
additional rendering time and it’s not always easy to integrate their 3D 
space with After Effects’.

Of course, that means you have to use these assistants on 3D layers. 
Remember, we’re positioning them in 3D space, so it’s not much good if the 
layers are 2D and can’t be positioned in 3D space. If you try to use the 3d 
Assistants on a 2d layer, you will notice that the 3d Assistants are grayed 

out and cannot be selected.

You can arrange, re-arrange, re-position, and re-arrange again as much as 
you like. If you don’t like one configuration, change a few parameters and 
re-adjust the layers. Or hit undo to go back to your original layout. The 3D 

The Perfect Cube
As you might guess, creating a per-
fect cube requires 6 square layers 
that are all the same size.

Being that there aren’t many cam-
eras out there that capture video in 
a square, this presents a problem. 
You can either squish the normal 
video or mask out a square portion 
of the video.

Since much footage is captured 
with the screen safe limits of TV in 
mind, it’s often not difficult to cut 
a square chunk out without losing 
much. 

The 3D Assistants don’t recognize 
masks on layers. They still see 
the layer at it’s full size. The way 
around this is to drop each layer 
into it’s own square pre-comp.

If you have a bunch of square 
pre-comps, all you need to do in 
the Box Creator is click ‘Fit Box To 
Layers’ and click Apply. This will 
make a perfect cube.
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assistants give you a very powerful and easy way of arranging 3D layers.

If at this point in time you’re going “hmm, this sounds neat, but I don’t get 
this whole 2D/3D thing. Maybe I should go read a good book instead.”. 
Yes! You should go read a good book. Preferably one that explains how 
After Effects’ 3D system and layers work. In the back of this manual you’ll 
find a list of resources (books, DVDs, web sites, etc) for finding out more 
about AE’s 3D space. 3D space can be difficult getting your head around, 
and there is already plenty of well written stuff about it, including the 
manual that comes with After Effects. It didn’t make much sense for us to 
rewrite chapters of the AE manual. However, we do touch on some basic 
concepts here and there, but you’ll be much better off if you go through 
AE’s manual and some of the third party materials.

           

3D Space
All of the 3d Assistants conform to After Effects’ 3d coordinate system. The 
origin of After Effects’ 3d space (x=0, y=0, z=0) is always the upper left 
corner of the composition, regardless of the composition’s size. All the assis-
tants default to the center of the current comp. Usually this won’t be a prob-
lem, but it’s something to be aware of. If something else has already been 
set up around AE’s center of 3D space, the Assistants will position things 
slightly off of center.

Keyframe Assistants
Unlike some other keyframe assistants, like The Wiggler, the 3d Assistants 
do not need keyframes to be present in a layer in order to function. In 
fact, they weren’t designed to set keyframes at all. You can use them to set 
keyframes but mostly they’re designed to arrange layers in 3D space. This 
doesn’t require keyframes unless you want to animate the position or orien-
tation of your layers.
  

You can pretty easily create a ‘TV 
Wall’ that will flash images or even 
have the images move around. 
Here we’ve used the Place Layers 
Randomly parameter that’s in the 
Matrix Creator.

Place Layers Randomly will take 
the selected layers and, surpris-
ingly, place them randomly in the 
grid. This can be very cool if there 
are more grid spaces than layers. 
The empty spots will move around 
too.
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Some great resources: Creating Motion Graphics by Trish and Chris Meyer, Total AE 
training tapes by total training (you can buy Total AE on www.digitalanarchy.com), and 
Creative After Effects by Angie Taylor. All are excellent references.



There is no limit to the number of layers that you can simultaneously apply a 
3d Assistant to. In fact, the ability to distribute large groups of layers is one 
of the most useful aspects of this software. You can even use the assistants 
to replicate your layers and create large groups of layers. Be careful about 
this, tho… you can easily turn 7 layers into 700 layers which won’t have 
happy results if you don’t have enough memory for 700 layers.

Layer Order
The 3d Assistants distribute 3d layers in the order they are arranged in the 
Time Layout Window. If your animation requires that there be a certain 
order to your layers, like if you were animating several letters to spell a 
word, be sure to arrange your layers in the proper order in the time layout 
window before applying the 3d assistants. Some of the assistants handle 
this differently than other ones. When we get to those assistants will discuss 
how they work.

All numeric values used in the 3d Assistants represent pixels. That’s how 
AE’s 3D space works, so that’s how we work.  
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Nasty Intersections

The great thing about AE’s 
Advanced 3D Renderer is that it 
can render intersecting layers.

Of course, you don’t always want 
to see intersections and in fact, 
would prefer to avoid layers inter-
secting altogether.

Unfortunately, the 3D Assistants 
don’t help here. Currently there is 
no collision detection in any of the 
assistants. Even if there was, since 
we don’t control the animation, 
the layers would intersect when 
animated.

In simple cases, try using expres-
sions to prevent collisions.

The order that layers get placed is pretty much how you would expect. Layer 1 is placed first, 
Layer 2 is placed second, Layer 3 is placed third, and so on and so forth utnil it runs out of layers 
or the world ends.



Distribution vs. Creator

No, this section is not about the ongoing debate of whether it was God’s 
magic hand or a huge, flying turtle distributing little gummy seeds that 
resulted in us being here. While it’s true that many times we have argued 
long into the night in the turtle’s favor, we will not do so here.

Actually this is about the two types of 3D assistants. The Distribution assis-
tants and the Creator assistants.

The Distribution Assistants

In the 3D Assistants Lite package there is only one Distribution assistant, 
Cubic Distribution. Cubic distributes the selected 3D layers throughout 3D 
space. With Cubic, you define the area of a cube and the assistant takes 
care of placing them throughout that area. The layers can either be placed 
randomly or by following the parameter values you set up.

This assistant make it very easy to place a large number of layers through-
out 3D space. You control how they’re distributed and how they’re oriented 
by making a few selections in the assistant itself.

Alpha Channels

One nifty trick that you can do in 
AE is use 3D layers with alpha 
channels. 

This becomes particularly powerful 
when used with the 3D Assistants. 
You can distribute many of these 
layers in space and make it look 
like your flying through stars, birds, 
or fireworks and explosions. That’s 
what’s happening here.

We started off with 5 layers, 
repeated them several times 
throughout 3D space and then flew 
the camera through them. While 
it’s not exactly Star Wars, it is 
pretty effective.
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The Creator Assistants

The Creator assistants are a different beast. They are designed to create 
the selected primitive out of the layers you select. For example, creating a 
video wall, a cube, a ring or other shape. This allows you to quickly set up 
common shapes all within AE’s 3D space. 

You just need to set the dimensions, how the shape is going to look, and 
how many layers you’re going to use. The assistants do the rest, calculating 
all the position, orientation, and scaling information.

Of course, you can also animate from shape to shape. Set one shape, set 
a few keyframes, then arrange the layers into a different shape. AE will 
take care of the animating. Since the assistants aren’t calculating all the in-
between data, there’s no way to prevent the layers from intersecting or cross-
ing over in front of each other. If you need to prevent the layers from doing 
this, you may have to go in and manually tweak some of the animation 
paths. Since AE is doing the animation, it’s easy to tweak the animations. 
Just adjust it like you would any normal animation curve.
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Damn D1

What to do about those pesky 
non-square pixels? After Effects 
being the really cool app it is, 
generally helps us out and we 
don’t have to worry about it.

At least, until we use 3D.

AE compensates for the non-
square pixels, but in doing so 
throws off the placement of 3D 
layers. Notice the gaps on the 
lower cube (in red). Not pretty.

The top box is what it should look 
like.

So how do we get that top box? 
Square pixels! Interpret your 
footage so it uses square pixels 
and make sure your comp is using 
square pixels. If so, everything is 
happy and the Assistants can put 
things together correctly without 
AE misinterpreting what’s up.



Some Concepts

RAM (Don’t Crash Your Machine)

Layers need RAM. If you’re just building a cube, then it’s no big deal. In 
fact if you’re building half a dozen cubes, it’s probably not going to be a 
big deal.

However, with the Repeat Layers option (see below), it’s very easy to create 
hundreds of layers. I mean REALLY easy. Don’t accidentally repeat your six 
layers 10 times… then repeat the resulting 60 layers, another 10 times. Be 
careful about that Repeat Layers function.

Orientation

There are two ways to rotate a layer in AE’s 3D space. The orientation 
parameter or the rotation parameters. When the assistants need to rotate a 
layer, they use orientation. This sets a layer in a particular ‘pose’. Unlike the 
rotation parameters, where you can have a layer flip around infinitely, the 
orientation only lets you rotate the angle from 0 to 360. This works well for 
animating a layer from the bottom of a box into a video wall or something. 
Since that’s the type of thing the assistants were designed to do, we use ori-
entation.

If you want layers spinning wildly, you’ll need to manually set for the rota-
tion values.

Ignored Layers

When an Assistant can’t use all the layers selected (for example, when you 
have 10 layers selected and you’re making a 6 sided box), the Assistant 
will ignore the unused layers. Leaving them untouched in their original posi-
tion. Make sure they don’t get in the way. Either move them or position the 
primitive away from the original layers. 

Primitives

Primitives are the basic building blocks of 3D: cubes, spheres, a plane, cyl-
inders, etc. You’ll see them referred to in this manual frequently.

Gradient!
Ok, so this has nothing to do with 
the 3D assistants. It’s pretty and it’s 
left over from the manual to our 
Gradient! plug-in. Gradient! cre-
ates cool, pretty stuff like this and 
it’s inexpensive.
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Advanced 3D Renderer

      

If you go to your Composition Settings (Command/Control + K), in the 
Advanced section you’ll see you have the choice of two renderers. The 
Standard 3D Renderer, and the Advanced 3D Renderer. This should almost 
always be set to the Advanced 3D Renderer. If it isn’t, you’ll see very 
strange behavior if your 3D layers intersect.

If your layers aren’t going to intersect, then the Standard 3D Renderer can 
be somewhat faster. However, for most work, you’ll want the Advanced 
version. If you’re in AE 5.0 this option is not available, but is worth the 
upgrade price by itself.

D1, Non-Square Pixels, and Other Spacing Issues

You may run into problems when using the 3d Assistants with compositions 
and footage with non-square pixels. Specifically, in situations where you 
need layers to line up edge to edge, the 3d Assistants will not always give 
you the desired result. Because the aspect ratio is different, AE aligns them 
differently than square pixel images. This is the way AE works and at the 
time of writing this manual, we were unclear on exactly what AE is doing. 
We hope to release an update that offers some controls to help alleviate this 
problem. The suggested workaround is to use the 3d Assistants in a com-
position with square pixels, and nest that comp into your non-square pixel 
comp. For more random arrangements of layers, the 3d Assistants will work 
fine in non-square pixel comps. 

Even with square pixels, AE’s 3D space sometimes will render gaps 
between layers that are perfectly aligned. You can scale your layers up 
slightly, set it to 100.5% (or some similar percentage) once they’ve been 
placed or start out with them all at 99.5% and scale them up to 100 once 
they’ve been placed. Which you use is up to you and will depend on how 
your defining the shape you’re creating. 

Arrangements

With the Assistants you can create 
all sorts of cool layer arrangements. 
In this case we’ve used the Linear 
Assistant to create a virtual Holly-
wood Squares filled with clouds or 
cotton candy or somehting.

With the Linear Assistant we lined 
up one set of layers along the 
Z axis facing the XY plane, and 
another set along the X axis facing 
the YZ plane. Next thing you know 
we have a whole carnivals worth 
of cotton candy.

Ok we lied. They are actually 
clouds off of one of the ArtBeats 
stock footage CDs. Neat stuff. 
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On the left is an example of the Standard 3D renderer. Notice how the pink cloud layer 
appears on top of the orange cloud layer. The image on the right is the Advanced 3D 
example, which is how things should look. Notice how the layers are intersecting.



Common Parameters

Starting Point

the Starting Point of all the Lite Assistants is set to the center of your compo-
sition. For example, if your composition is 640 x 480, the starting point will 
be 320, 240, 0.

Keep in mind that AE’s 3D space defaults to 0,0,0, which is the upper left 
corner of the comp at the defualt view. So even though your layers are in 
the center of your comp window, they are not (usually) in the center of AE’s 
3D world. Most of the time this won’t make any difference, but it’s some-
thing to be aware of... especially if you have other 3D layers that aren’t 
being affected by the 3D Assistants.

Size or Dimensions

This sets the size of the bounding box that contains the primitive that the 
layers will be distributed in. In the case of the Cubic Distribution, this is 
exactly the size of the cube that is created. In the case of the other distribu-
tion assistants, this will only set the boundaries for the other primitives and 
the actually distribution space will vary depending on the primitive. Please 
see the illustrations.
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20,000 Pixel Tunnels

Are pretty easy to make if you 
have the memory for it. Just repeat 
layers as desired and make sure 
you set the Height to your layers 
height.

Set up the cylinder creator with the  
‘Radius Set By’ parameter set. In 
this case we set it to 8. To create 
the spiral effect you see, we then 
selected 9 layers. One layer was 
always left over have the 8 spots 
in the radius were taken up. So 
the ninth layer is shifted down and 
everything starts over. Resulting in 
the spiral you see.

The Squares around the shapes are the bounding boxes. The primitive shapes are then 



Random Layers

This will cause the layers to be selected randomly as they are being placed. 
The Layer Order is ignored. 

Layers will not be used twice, so once a layer is selected and placed, 
another layer is randomly selected. This doesn’t affect placement; layers are 
placed exactly as they would be if the normal layer order was being fol-
lowed. The only difference, is instead of going down the timeline 1… 2… 
3… 4… when placing the layers, it goes 5… 2… 8… 6… etc.

Repeat Layers

This can be very useful if you’re trying to quickly fill an area up with layers. 
It can also crash your machine. Repeat Layers will automatically duplicate 
your selected layers however many times you tell it to. Say you have 7 
layers and you want those layers duplicated 7 times, you just enter in 7 
in the value box, and when you click ‘Apply’, not only will the original 7 
layers be placed, but 49 extra ones will be as well.

By using this you can quickly and easily experiment with extra layers and 
figure out exactly how many you need without duplicating and/or deleting 
them manually. If 49 isn’t enough, just click Undo, enter in 10 instead and 
click apply. Maybe 70 is the magic number.

The downside to this is if you have 49 layers selected, you forget that 
Repeat layers is on, and you repeat the 49 layers 10 times. You now have 
490 layers, and unless you have a lot of RAM, you’re in trouble. This can 
potentially crash your machine. So just pay attention to this and make sure 
you’re not going to create more layers than you have RAM for.

This differs somewhat from the behavior of Repeat Layers under the Creator 
Assistants. The Creator Assistants will eventually stop repeating layers if it 
runs out of space for them. The Distribution Assistants, never really run out 
of space, so they never stop repeating. This is what potential could crash a 
machine.

Seams and Overlapping

Occasionally AE’s Advanced 
3D Renderer will render seams 
between layers where there 
shouldn’t be one. This can be par-
ticularly obvious between layers of 
flat color.

To get rid of this your layers need 
to overlap by a few pixels. One 
way of doing this is to scale all 
your layers down to somthing 
like 99.5% and then place them. 
Once they’ve been placed by the 
Assistants using the smaller size, 
increase them to 100%.

The Assistants place the layers 
thinking the 99.5% is their real 
size. So all the calculation are 
done with that in mind. Then when 
you scale everything back up to 
100%, all the layers overlap, just 
slightly and usually enough to get 
rid of any unseemly seams.
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The image on the left shows how the timeline looks after a normal Repeat Layers, and the 
image on the right shows what happens with Repeat Sequentially turned on.



Repeat Sequentially

This only works if Repeat Layers is turned on. Normally, layers will be 
repeated right next to each other. For example, if you repeat your layers 
once, your timeline will look like this:

If you select Repeat Sequentially, the layers are treated as a block, and 
when they’re duplicated the whole block gets placed after the last layer. It’ll 
look something like the illustration above.

Layer Orientation

This determines how the layers are oriented. Regardless of whether the 
layers are being distributed along one, two, or three axes, you need to 
determine what axis they will be oriented around.

- None: No effect on layer orientation. Use this if you only want to 
reposition the layers and not have the assistant change the orienta-
tion.

- Towards Camera  Orients all layers towards the selected camera. 
This will change the orientation along all axes if necessary.

-    Random  Orients layers randomly around all axes.

Insert Keys

The checkboxes in this section, allow you to specify which properties will 
have a keyframe set for them. This is a convenient way of setting the appro-
priate keyframes if you want to eventually animate your layers. You can cer-
tainly do this from the main AE interface, but this is a bit more convenient 
and makes sure you set keyframes for all the necessary properties.

The position check box will set a keyframe for the Position property for all 
the selected layers, the Orientation checkbox will set a keyframe for the 
Orientation, and the Scale checkbox will set a keyframe for Scale property. 
Obviously all of these may not be necessary for your animation. If you’re 
just moving your layers forewords or backwards in 3D space, you may only 
need to set Position keyframes. However, if you’re transforming your layers 
from a box to a sphere, you’ll need to set a Rotation keyframe as well.

This only sets keyframes at the point where the Time Marker is on the time-
line. Remember to de-select them if you move to a different point in the time-
line, but don’t want to set keyframes. Once you turn them on, they stay on 
until you turn them off.
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Rings and Filmstrips

There are a great many shapes 
and effects that you can pull off 
with the 3D Assistants. You can use 
the Spheroid Creator Assistant to 
create rings or use the Linear Assis-
tant to lineup a sequence of images 
into a film strip.

Of course, don’t forget about all 
the cool tools you have within After 
Effects, like projection lights, shad-
ows, and the material options.

We hope the 3D Assistants will 
really allow people to take better 
advantage of the AE’s 3D space.



Cubic Distribution Lite

Cubic Distribution distributes layers within a 3d space defined by a cube or rectangular area. It is not 
to be confused with Box Creator, which distributes layers based on the surface of a cube or rectangu-
lar solid. (For simplicity’s sake, this shape will be referred to as a cube from this point forward, but it 
should be understood that the shape can also be a rectangular area.) To use the Cubic Assistant, select 
the 3d layers in your composition that you wish to distribute within a cube, and go to Window> Cubic 
Assistant Lite. 

The layers are placed randomly throughout the 3D space.  As you’ll notice from the image below, 
layers are placed all along the three axes. Random orientation appears on the right side, while the 
same distribution with no orientation change appears on the left.

Cube Dimensions (Also: See Common Parameters)

These settings define the size of the cube in which the selected layers will be distributed. The size limita-
tion of this cube is 1,000,000 x 1,000,000 x 1,000,000. Which would be a pretty big damn cube. 
Values of 2000-5000 are much more normal and practical. 

Layers will then be randomly placed throughout this area. Every time you click Apply, the layers will 
re-position themselves. Just keep clicking Apply until you get a distribution you like, or adjust the cube 
size and re-position them. This is one of the great things about the Assistants... the ability to quickly and 
easily make changes and experiment to get the exact effect you’re looking for.

The Cubic Distribution Assitants provides a particularly valuable function. It allows you to easily create 
the illusion of 3D Space. It’s difficult for any viewer to get a sense of the scale of the 3D world you’re 
trying to create without reference layers. Usually these are layers off in deep space which noone will 
ever see up close, but they provide that important reference. Cubic Distribution provides an easy way 
of placing lots of these layers giving users that sense of ‘depth’ that’s necessary to sell 3D space.

Layer Orientation - (See Common Parameters)

Options- Random Layer Selection (See Common Parameters)

Insert Keys See Common Parameters
15



The Box Creator Lite

The Box Creator is for distributing layers based on the surface of a cube. 
This can be used to create cubes, boxes, tunnels, walls, and other effects. It 
is not to be confused with Cubic Distribution that distributes layers within a 
cube. To use the Box Creator, select the 3d layers in your composition that 
you wish to distribute on the surface of a cube, and go to Window> Box 
Creator Lite. 

Options- Random Layer Selection  See Common Parameters

This setting will cause your selected layers to be placed on the surface of 
the cube in a random order, rather than in the order they appear in the time 
layout window. The usual layer order will be ignored completely. 

Box Dimensions:

These values represent the dimensions of the box that will serve as the 
template for layer distribution. Be aware of your layer sizes when using 
this assistant. A perfect cube can only be created when all the layers are 
squares, and are the same size. If you’re layers are not square and the 
same size, you will see gaps where the edges don’t meet perfectly.

This is a pretty important concept. If your layers aren’t the same size, you’re 
going to have difficulty creating a well formed shape. By that I mean a 
shape without gaps where the layers are aligned and the edges meet. Of 
course, this may not be an issue, depending on what you’re doing. How-
ever, if it is, try using layers with similar dimensions.

Make sure you have enough layers to create what you want to build. A 
cube requires 6 layers, a tunnel may require 60. A little pre-planning and 
thinking about the number of layers and the size of the layers will go a long 
way to getting what you want. You can use the Repeat Layers option, but 
one way or the other, you need to get the right amount of layers.
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Inside Out

While viewing the shapes from the 
outside might be the initial reac-
tion, try going inside. Here we 
have a view from within a sphere 
created with the Spheroid Creator. 
From the outside this looks like a 
bunch of intersecting layers (which 
it is). From the inside, it looks like 
a massive video wall or control 
room.

Use your imagination. There’s 
many ways these can be put to use 
and we just scratch the surface in 
this manual.



The above image shows: 1) a well formed cube with square layers that are the same size, 2) A ‘Fit Box 
To Layers’ box with non-square layers, 3) a box with sides that are larger than the layers.

Fit Box to Layers

This setting will automatically size the box based on the dimensions of the selected layers. It is most 
effective when used to create a simple 3d cube or box using square layers. When using Fit Box to 
Layers, it is best to select the same number of layers as there are active faces (see below) on your cube. 
For instance, if you wanted to create a cube, you should select 6 layers; one for each face. If you 
wanted to create a box with no top or bottom, you would select 4 layers. 

If the layers are not square, the assistant will make the best attempt to arrange them without the gaps 
being too large. However, any non-square layers will result in gaps and this is unavoidable. Again, 
make sure your layers have similar dimensions.

If you look at the second image in the above illustration, this was used to create that box.

One Layer Per Side / Layer Order

This option will limit the box to one layer per active face. If there are extra layers selected, they will be 
ignored by the assistant. It’s important to understand layer order for this assistant. The assistant will first 
place a layer on the front side, and go counter clockwise from there. The right side will get the second 
layer, the back will get the third, the left side will get the fourth layer, and the top and bottom will get 
layers 5 and 6. It will look like this:

All layers are placed in the center of the box side. If the box side is larger than the images, the images 
will be placed dead center in the sides of the virtual box. In this case you won’t see the edges of the 
box as there’ll be gaps. Use ‘Scale Layers To Fit’ to match the layers to the box size.\

Scale Layers to Fit
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This option will automatically scale the selected layers so that they match 
the dimensions of the cube. This is extremely useful if you’re trying to make 
a perfect box. It’ll scale the layers up to the required size. Use this option 
to make boxes out of layers whose sizes differ or whose dimensions don’t 
match the desired box size. Of course, the problem here is that the layers 
are scaled, so they may not look distorted or pixilated.

Again, it helps to prepare your files in advance, although where layers are 
only be scaled slightly it works fine. It also works great for creating cubes 
out of solids. Just create a solid of any dimension, repeat it 5 times and 
scale it to fit. Instant color box!

Multiple Layers per side

Selecting this option will allow multiple layers to be distributed on each 
face of the cube. Unlike ‘one layer per side’ this positions the first image in 
the upper left corner (instead of the center) and places subsequent images 
clockwise around the side of the cube. Of course, in this case it behaves 
like the Matrix Creator when placing more than one layer on each side. 

Here’s an interesting use of multiple sides to create a four walled tunnel. 
Simply set the width of the box sides to match the width of  your layers, 
make the box really tall, and turn off the top and bottom.

Animations

Remember that these were 
designed to assist with creating 
animations. There are many ways 
of creating interesting animations.

Try using the results of one Assis-
tant as the basis for another one. 

For example, use the Spheroid Cre-
ator to create a ring of layers. Then 
pull all those into one central point 
with the Lienar Assistant. Make 
sure you have NONE selected in 
the orientation. Set a keyframe.

Now stretch those layers out, with 
the Linear Assistant again. Align 
them right next to each along one 
of the axes (this time changing the 
orientation).

When you animated, it looks like a 
deck of cards unfolding. Very neat 
effect.
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Repeat Layers See Common Parameters

Active Faces

These settings decide which faces of the cube will be used for layer distribution. Selecting “All” will 
make all 6 of the cube’s faces active. Any combination of these faces can be selected. For example, if 
you wanted to make a box with no top, you would select front, right, back, left, and bottom.

This allows you some very cool flexibility with this. You can create tunnels, arrange layers to form rooms 
or whatever suits your fancy.
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Orientation- Layers Face Outward, Layers Face Inward

Sometimes you want to be on the outside looking in, and other times you 
just want to be on the inside staring out. Regardless of where you choose to 
be, these options will let you see the layers correctly. If you’re point of view 
is from inside the box, orient the layers inward. If they are oriented out-
wards, any writing or images on them will appear backwards. Likewise, if 
you’re one of those nifty internet people who like to think outside of the box, 
orient your layers outwards. Can’t really think about the box if you can’t see 
the box and orienting the layers outward will cause everything to look cor-
rect.

Insert Keys See Common Parameters
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Illustion of 3D

One of the things you need 
to do when dealing with 
3D is to sell the viewer on 
the fact that you’re in a 3D 
space. One way of doing 
this is to place elements far 
in the background and else-
where within the 3D space, 
so viewers have reference 
points.

Most likely the viewer will 
never see these reference 
layers up close or even 
as much more than small 
rectangles of color. How-
ever, they’re very important 
in letting your viewer get a 
feel for the scale of your 3D 
world.

The Cubic Distribution 
Assistant is great for placing 
layers randomly throughout 
3D space. Making it very 
easy to create the sense of 
depth and space necessary 
to sell the effect.



Cylinder Creator Lite

The Cylinder Creator is used for distributing layers based on the surface of a cylinder. The Cylinder 
Creator will attempt to create a cylinder based on the layers you give it. It arranges the layers in a 
circle with a given radius, and then stacks the rings of layers to form the cylinder. This works best if all 
the layers have the same width. Otherwise, the assistant can’t keep all the layers inline and the cylinder 
ends up being a hodge podge of rings. This may be fine, but if not, make sure everything is the same 
width.

To use the Cylinder Creator, select the 3d layers in your composition that you wish to distribute on the 
surface of a sphere, and go to Window> Cylinder Creator Lite. 

Dimensions/Bounding Box (Also: See Common Parameters)

Radius Set By

This causes the radius to be determined by the first several layers in the timeline. The exact number is 
set by the value of the parameter. For example if you set it to 5, the first 5 layers in the timeline will be 
used to determine the radius of the first ring in the cylinder. This sets the radius for the cylinder and all 
subsequent rings of layers will approximately be this size. 

When this is selected the ‘Y’ value of the bounding box is still active. This sets the height of the cylinder. 
The Assistant will calculate how the layers should be positioned around the cylinder, but you still need 
to tell it how high you want the cylinder and how frequently the rings should be placed vertically.

This is particularly effective when all the layers have the same width. The rings are all the same size 
and all the layers in the ring are the same distance from each other. If layers are different sizes then 
there’s no way to create a perfect cylinder and you’ll see gaps. As you can see in the image below, 
if the images aren’t the same size (right-most image) everything is helter skelter. The left and middle 
images show cylinders with a radius of 3 and 6 layers respectively. In both those cases the images are 
the same size and the rings fit together perfectly.
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Distribute Evenly

Choosing this option will result in the selected layers being distributed evenly around the surface of 
the cylinder as possible. Given the number of layers and the size of those layers, this may not always 
work great. Particularly with very oddly shaped layers or a lot of layers over a small surface. However, 
usually it will give you the most even distribution of layers across the surface of the sphere. Selecting 
this option also disables the ‘Radius Set By’, ‘Distance Between Layers Vertically’, and ‘Frequency Of 
Layers’ parameters.

Distance Between Layers Vertically (Dist.) and Frequency of Layers Around Cylinder (Freq.)

These settings determine how far apart the layers will be distributed on the surface of the sphere. 
Dist.sets the vertical spacing of the rings of layers. You need to be aware of how many pixels high your 
layers are in order for this to work correctly. For example, if your layers are all 240 pixels high, and 
you want to create a seamless cylinder without any overlap, you’ll need to set the Height min/max to 
240. This will place a new ring of layers every 240 pixels. Since you’re layers are 240 pixels high, 
this creates a seamless cylinder.

In the image below, the left-most image has the Dist. set to a smaller value than the height of the layers, 
the middle image has it set to exactly the height of the layers, and the image on the right has it set to a 
value that’s larger than than the layer height.
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Freq. determines how of often a layer gets placed around the diameter of the cylinder. This is the angle 
at which a new layer is placed. If it’s set to 30, then a new layer will get placed every 30 degrees. The 
smaller this value, the more dense the cylinder will be, as it’s basically increasing the resolution of the 
cylinder diameter. Of course, depending on the size of your layers, this will potentially introduce more 
overlapping of layers.

Freq. is turned off if ‘Radius Is Set By’ is turned on, since the radius is determined by how many layers 
are selected. In that case the angle is going to be determined by the size of the layers and how many 
of them there are. 

Orientation

The two choices for layer orientation in the Cylinder Creator are Inward and Outward. Inward will 
cause layers to be oriented towards the center of the sphere, while Outward will cause layers to be ori-
ented away from it.

The way they should be facing is really a matter of where the camera is at. If the camera is inside the 
cylinder, most likely you’ll want to see the layers facing you. If you want them facing you and readable 
you need to have them facing inward. If they’re facing outward any text or image will appear back-
wards.

If the camera is outside the cylinder and you want the layers looking normal, have them facing out-
ward.

If the camera is flying around outside and inside and all over the place then you’re screwed. You’ll just 
have to deal with seeing the backside of the layers. Oh, the humanity!

Random Layer Order- See Common Parameters

Repeat Layers- See Common Parameters

Insert Keys- See Common Parameters
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 Resources
Most of the training tapes and books cover concepts that can be used no matter what version of AE 
you’re using. Don’t think that just because it’s for AE 5.5 that it’s not any good. The AE programmers 
do a great job of building on prior versions so that your knowledge (and these training materials) don’t 
get obsolete.

Training Tapes/DVD

Total Training (www.totaltraining.com) - Probably the best training resource out there. Total AE 5.5 is 
like having a world class instructor always on hand. Not too mention they use the Cylinder Creator in 
the opening sequence of the DVDs!

Books

Creating Motion Graphics with After Effects by Trish and Chris Meyer

After Effects In Production by Trish and Chris Meyer

The two Trish & Chris Meyer books together make the best printed training resource out there. Extremely 
comprehensive and you can get a couple free Digital Anarchy filters on them!

Creative After Effects by Angie Taylor

AE Magic by Mark Christianson and Nathan Moody

Web Sites with forums and tutorials:

Creative Cow: www.creativecow.net

Digital Media Net Forums: www.dmnforums.com

Adobe User to User Forums: www.adobe.com

2-Pop: www.2-pop.com

User Groups

Motion Graphics - Los Angeles: www.mgla.org

Bay Area Motion Graphics User Group (San Francisco): www.bamg.org
 
Toronto AE User Group: www.mograto.com 
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